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Prerequisites  
In order to fully participate in this workshop, you must be able to: 
 

• Save a file to a specific directory/folder using the "file/save as ..." process  
• Create a directory/folder during the file save as process  
• Comfortably move between multiple application windows using the task 

bar at the 
• bottom of your screen  
• Find files on your computer using the Find tool  
• Open a program using the start menu  

 
If you do not know most of the listed skills above, we strongly suggest that you 
sign up for the prerequisite workshops before taking this workshop. 

• LRO-WIND-101 Fundamentals of Windows 98 
 

Goals for this workshop  
  
In this workshop, you will learn: 
 

• What is Power Point?  
• How to start a New Presentation  
• How to create a slide show using the slide "AutoLayout"  
• How to create Custom Slides  
• How to manipulate slides in the Different Views  
• How to work with the Slide Master  
• Tips for designing effective Power Point Presentations 
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Before we get started  
 
Before we get started, you will need to download a few files from the web that we 
will need for this workshop. To do this, you will need to right-click on the three  
links below. Once you do so, you will get a menu that look like this: 
 

 
 
You want to choose "save link as." You will then be given a window that asks you 
where to save the file. For this workshop, you can put the files in the c:/temp 
directory. 
 

 
 
 

IRC Logo 
PPT slides for Ex. 3 
PPT slides for Ex. 4 
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What is Power Point?  
 
Power Point is based on the metaphor of a slide show presentation. In essence, 
it is designed to create overheads -- or its modern day equivalent-- a computer-
based presentation that you can quickly go through by pressing one button on 
the computer to display the next "slide." 
 
The building block of the PowerPoint presentation is the slide. A complete slide 
show is just a bunch of slides created individually and then displayed one right 
after the other. PowerPoint provides you with a large number of tools for working 
with slides and creating commonly used objects such as graphs, tables, org-
charts, and so on. This abundance of tools often intimidates the new user and 
gives them the impression that PowerPoint is a very complicated program. 
However, if you learn just the basics this workshop covers you can create 
sophisticated slide shows and learn how to use the individual tools when you 
need them. If you just keep in mind that PowerPoint is essentially just a "toolbox" 
for building and working with slides then everything should fall into place. 
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Starting a New Presentation  
 
To start a new presentation, first open PowerPoint (on the computers in the lab, 
you can usually open PowerPoint by clicking on start, then programs, and then 
Microsoft PowerPoint).  
 
When you first open up PowerPoint, it usually gives you a choice of starting using 
the Auto Content Wizard, a design template, or a blank presentation. To get us 
started, click on blank presentation. 
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The Slide  
 
The computer will now ask you to choose a slide and give you a list to choose 
from. Notice when you click on a slide, a description of that slide appears on the 
right. Take a minute to scroll through & see what different options there are (and 
these are only the built in options! You can also make totally original slides).  
 
For our first slide, we are going to choose a title slide. The title slide is the very 
first one. Click on it, and notice the words title slide appear on the right. Now click 
OK. 
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Introduction to Objects 
 
The Normal View we see now is for manipulating individual slides. Notice there 
are three windows in the normal view: 
 

• a slide view window (on the right)  
• an outline window (on the left)  
• a notes window (under the slide view window)  

 
In the Slide View Window, Go ahead and click where it says "click to add title" 
and delete it and put your own title. When you clicked on "click to add title" you 
probably saw a grayish box appear around "click to add title". This is called a text 
box and it is the object you use to put text on a page.  
 
There are lots of different types of objects in PowerPoint but they are all 
positioned and resized in basically the same way.  
 
Move your mouse pointer so that its tip is resting on the gray area of the text box 
as in the picture: (but not on one of the little white squares evenly spaced around 
the box).  

 
You should see the tip of your mouse pointer change so that there 
are arrows pointing north, south, east, and west. Click and hold down the left 
mouse button and move the mouse. The text box should move with your mouse 
so that you can reposition it somewhere else on the page. Go ahead and move it 
around a few times.  
 

Now, let's try to resize it. Position your mouse pointer so that its tip rests 
on one of those little white squares, which are evenly positioned around the text 
box.  This time your mouse pointer should have arrows pointing in only two 
directions, vertical, horizontal, or diagonal depending on which square you 
chose. Click and hold the left mouse button and move the mouse. This should 
resize the box in either the vertical, horizontal, or diagonal direction. Go ahead 
and resize it a few times in each direction. 
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Adding a New Slide  
 
Let's start by creating a new slide. Go to the Insert menu and select New Slide.  
 

You can also add a new slide by clicking on the  icon  or typing the Control 
key plus M.  You'll be prompted with a dialog box that says "Choose an 
Autolayout:" (This is the same box you got when you first opened your 
presentation.) 
 

 
Bulleted List Slide  
 
For our second slide, we are going to choose bulleted list (this is the second slide 
in the window).  
 
Go ahead & add a title to your second slide, the same way that you added a title 
to your first slide. Now, let's add some text to the larger text window. Notice that 
PowerPoint automatically puts bullets in for you.  
 

What if you want to indent some of the bullets. No problem! See the two 
arrows on your tool bar? Click on the line you want to indent & click the 

Demote  or right-pointing arrow.  Notice PowerPoint not only indents 
the line, but also makes the font smaller.  

 
Want to make some indented points more prominent? Click the Promote 

or left-facing arrow.  
 
You can also make other edits the same way you are used to in Word or 
WordPerfect (bold, italics, etc.) 
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Slide with graphics.  
  
Now lets add a slide with a graphic. How can we add a new slide? 
 
This time, choose the slide called object. 

 
 Notice that your screen now has a box that says "Double click to add object." Go 
ahead and double click on it. You should now get a box that looks like this: 
 

 
Notice that there are many different types of files you can insert into PowerPoint, 
including sounds, Excel spreadsheets, etc. For today, we are just going to add a 
graphic that has already been created. To do that: 

• click on the radio button next to "create from file".  
• click on "browse" to find the file on your local machine named 

"irclogo3.bmp."  
• PowerPoint will add your graphic in the correct place.  
• Resize your graphic if needed.  

Once you add the graphic, Power Point adds a picture menu to your screen 
that you can use to edit the image. 
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Paging Through your Slides  
 
Now that we have a three-slide presentation, how do we page through our 
slides? 
 
On the right hand side of the PowerPoint window you should see a vertical 
scrollbar with a single arrowhead at the top and the bottom of the scrollbar. 
Clicking on one of those arrowheads will move you to the next or to the previous 
slide. The top arrowhead goes to the previous slide. If you click on it, you should 
return to your bulleted list slide. The bottom arrowhead goes to the next slide. 
Clicking on it moves you to the next slide. You can also click and hold on the bar 
in the scrollbar and drag it until you get to the slide you want. As indicated in the 
lower left hand corner of the PowerPoint window this presentation has 3 slides. 
Go ahead and move through the slides until you are comfortable with it. 
 
You can also use the "Page up" and "Page down" keys on your keyboard to 
move through your slides.
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Let's Practice! Exercise #1  
 
Let's practice what we have done so far by trying the following things: 
 

1. Add a new slide to your presentation. Chose a "text & object" slide.  
2. Add a bulleted list on one side. It should list the IRC Instructional 

Designers:  
o Cindy McCourt  
o Jerry Drake  
o Sharon Widmayer  

3. Add the IRC logo on the other side. Your finished slide should look like 
this: 
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Custom Slides 
 
Now we are going to add a blank slide to our presentations. Remember how to 
add a new slide? 
 
This time, choose a blank slide from the AutoLayout. 
 
How can you add something to your blank slide? Notice on the bottom of your 
PowerPoint window, there is a tool bar that looks like this: 
 

 
 
In this section of the workshop, we are going to learn how to use this tool bar to 
add text, shapes, and color to your slides. 
 

 
Custom Slides: Adding Text  
 
To add text to your slide, click on the icon that looks like a little newspaper with 

the letter "A" on it ( ) and then click somewhere on your blank slide. Notice a 
text box appears. Go ahead and type something it in. Remember how to resize 
your text box? 
 

 
Custom Slides: Lines & Shapes  
 
Creating Graphics 
 
We can also create our own graphics to add to the slide. Click on Auto shapes on 
the bottom toolbar and add some objects to your page. Moving and resizing, 
these objects works just like the text object from Part 1. You can also experiment 
with WordArt and other drawing tools. We're not going to spend any time talking 
in detail about any particular drawing tools but take five minutes or so to see 
what's there and to experiment. Remember, you can always Undo. 
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Custom Slides: Adding Color  
  
 
To color your graphics, click on the object you want to color & then on the little 
down arrow next to the paint can to choose the color. 
 

 
 

To color a line, click on the little down arrow to the right of the paintbrush. How 
about coloring the text? Click on the little down arrow to the right of the "A." 
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Custom Slides: Inserting Graphics  
  
Inserting Graphics:  
 
To insert an already made graphic, on the top menu, click on "insert", then 
"picture", and then choose "from file" or "clip art." The graphic will appear on your 
slide & then you can move it & resize it as you wish. 
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Let's Practice! Exercise #2 
 
Let's practice what we have done so far by trying the following things: 
 

1. Add a new blank slide to your presentation  
2. Add a text box to the middle of your slide saying "Exercise 2."  
3. Make the words "Exercise 2" green.  
4. Draw three stars on your page using the Auto shapes tool.  
5. Color your stars red, blue, and yellow.  
6. Add the IRC logo about the words "Exercise 2."  

 
Here is an example of what your finished slide should look like: 
 

 



info@irc.gmu.edu 
Materials created by the Instructional Resource Center 

All rights reserved. 

Outline Window in Normal View 
 
On the left hand side of your screen in normal view, you can see an outline of the 
slides you have created so far.  
 
In the Outline we can reorder the slides, rearrange the textual content of the 
slides  (i.e. increase or decrease level of indentation, move text from one slide to 
another) and so on. 
 
First let's reorder some slides.   
You should see numbers going from 1 to 6 each with a little icon of a slide next to 
it.  Each one represents one slide you have made.  Let's move the second slide 
and put it after the third slide .   

• Click and hold the left mouse button on the little slide icon next to the 
number 2.  The entire contents of the slide should be highlighted and you 
should see the 4-pointed arrow at the tip of your mouse pointer.   

• Drag the mouse down (without letting go of the button) until you see a 
black horizontal line appear.  This line is where slide 2 will be inserted if 
you let go of the mouse button (don't let go of the button yet though).  

• Keep dragging down until the black horizontal line is directly above slide 
number four and release the mouse button.  You should see that the 
slides are renumbered so that what was formerly slide two is now slide 
three and vice versa.    

Go ahead and rearrange slides to your heart's content (Note that it is easier to 
rearrange whole slides in Slide Sorter View, but you can do it in Outline View 
too). 
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To see how you can change around your text in the Outline Window, first let's 
use our slide view window to add a new slide with a bulleted list that looks like 
this: 

 
 
Now let's modify the level of indentation of some slide text using the outline 
window.   Let's move the "languages" sub-point so that it is at the same level as 
the four other points.   

• Click and hold the left mouse button on the "-" next to "language" and drag 
to the left until a vertical black bar lined up with the top level bullets 
appears.   

• Now release the mouse button.  You should see that "language" is now on 
the same level as the points above it.   

• Now move it back by clicking and dragging to the right until the vertical 
black bar appears and then releasing.   

• Try using this same technique to increase or decrease the indentation 
level of the text on several slides.  Note that the changes you are making 
are being reflected on the appearance of the slide itself.    

 
You can also rearrange the order of the content in the Outline Window. Highlight 
the lines that you want to move. Then just click & drag them to where you want 
them to be. 
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Adding Notes to Power Point  
 
In normal view, where it says "Click to add notes." click, and add some notes to 
your presentation.  
 
You can use the notes view to type notes for yourself about your presentation, to 
add notes to handouts you want to print out, etc. 
 
If you would like to print your slides with notes (to give out as handouts, for 
example), once you choose to print, you will be given a print dialogue box. Under 
"print what", choose "notes pages." 
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Let's Practice! Exercise #3  
 
Let's practice what we have done so far by trying the following things: 
 

1. Open up the "ex3slides" file in the c:/temp directory (the one you 
downloaded at the beginning of the workshop).  

2. In the outline view, move "Summarize Product Resource" and it's sub 
points from slide 9 to slide 4.  

3. In the Notes View, add a note to the "Attention Areas" slide saying "I must 
remember how to add notes to PowerPoint!"  

4. Run the slide show. 
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Different Views  
 
PowerPoint provides you with six basic views of your slides.  Remember that 
each of these views just gives you a different way of looking at your slides to 
make it more convenient for you.   
 
To activate a different view, Click on the View menu and select the view you 
want. In the picture below, we are selecting the Slide Sorter View. 
 

 
 
There may also be a little view bar on the bottom of your screen. It looks like this: 
 

 
 
Each of these icons represents a different view (in order from left to right: normal 
view, outline view, slide view, slide sorter, slide show.) 
 
Here is a brief explanation of each view:  
 

1. Normal View - This is the view we have worked with so far.  In normal 
view, you are working with an individual slide in your slide view window, 
and can also see the outline of your presentation and the notes that 
accompany each slide.  

2. Outline View - This is basically the same as the normal view, with a bigger 
outline window and a smaller slide window.  

3. Slide view - This is basically the same as the normal view, with a smaller 
outline view and no notes window.  
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4. Slide Sorter View - This view shows you a miniature version of each slide.  
It is most commonly used for rearranging the order of the slides in the 
presentation or selecting groups of slides to apply some kind of formatting 
to.   Double clicking on one of the miniature slides takes you Slide View for 
that slide.  

5. Notes Page View - shows you what your printouts will look like if you 
choose to print notes pages. Note: In Office 2000, to get to the Notes 
Page view, click on "view" and then click on the down arrow at the bottom 
of the drop-down menu. You should now see a choice for notes view in 
the drop-down menu.   

6. Slide Show View - We saw this view at the end of the hands-on exercises 
for Part 1.  The Slide Show View is used for presenting the slide show.  It 
has a bunch of options that we can configure (we just used the defaults in 
Part 1) to set things like automatic advancing of slides after so many 
seconds, transitions between the slides, and so on. 

 

Normal View  
We have been working with this view thus far and hopefully you are comfortable 
with it. 
 

Notes View  
To go to notes view, click on the View menu and then the down arrows at the end 
of the drop-down menu. Now select Notes Page. Where is says "click to add 
text." click, and then add some text. Go ahead and add some notes. If you added 
notes in normal view, you should see them, too!  Move between slides using the 
scrollbar just like you did in Normal View. If you can't see the notes you are 
typing because they are too small rather than making the font bigger, you should 
use normal view. 
 

Slide Sorter View  
Click on the View menu and select Slide Sorter. You should see a miniature 
version of each slide represented. This is the easiest view in which to rearrange 
slides. Just click and hold on a slide and drag it to a new location. Go ahead and 
move your title slide to the end of your presentation by clicking and holding on it 
and dragging to the end of the presentation. A short vertical black bar will appear 
after the last slide. Now release the mouse button & you should see that your title 
slide has moved! Go ahead and move some other slides around.  
 
Sometimes you'll want to select multiple slides to do something to them as a 
group.  Say, for example, that we want to delete slides number 2 and 3. Click 
slide 2 and then hold down the Shift key and click slide 3. They should both have 
a darker black border around them than the other slides to indicate that they are 
selected. Then press the Delete key. Poof, they are gone. This seems like an 
appropriate time to mention the extremely useful undo feature of PowerPoint. 
Let's suppose we had accidentally deleted slides 7 and 8 and we want them 
back. Click on the Edit menu  and select Undo Whatever. The slides should 
reappear. 
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Outline and Slide View  
 
Outline View is the same as Normal View, with a larger outline window and 
smaller notes and slide window.  Slide View is the same as Normal View, with a 
much smaller outline window, a much larger slide window, and no notes window. 
 

Slide Show  
  
Last but not least let's take a look at what we have done using Slide Show View. 
This is the view you use to actually present your electronic slide show. Click on  
the View menu and select Slide Show. The current slide should fill the screen 
and all the PowerPoint menus and toolbars should disappear. If you had, for 
example, a laptop hooked up to a projector, then you would present in just this 
fashion. Hit the spacebar or the left mouse button to proceed to the next slide. 
You can also use the Page Up & Page "Down" keys to page through your slides. 
When you reach the end of the slide show it should return to Slide View and all 
the menus and toolbars should come back. You can hit the ESC key to quit out of 
Slide Show View before you reach the end of the slides. 
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Let's Practice! Exercise #4  
Let's practice what we have done so far by trying the following things: 
 

1. Open up the "Ex4PracticeSlides.ppt" file in the c:/temp directory (the one 
you downloaded at the beginning of the workshop).  

2. In the slide sorter window, move "Recommendation" from slide #7 to Slide 
#2.  

3. Delete Slide #4.  
4. Add a new slide after slide #1.  
5. Run the slide show. 
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The Slide Master  
 
Before you close your Exercise 3 presentation, add a new slide to it. Notice 
anything? When you create a new slide it came in with that yellow background 
image and with pre-made font selections and so on. Where did all that stuff come 
from? It came from the Slide Master. The idea of Masters is that you will want 
your presentation to have a consistent look and feel. You might want a logo on 
every slide, the font to be the same in all the text boxes and so on. The Masters 
store this common formatting and then apply it to new slides automatically. There 
are four Masters: the Slide Master, the Title Master, the Handout Master, and the 
Notes Master. We are only going to concern ourselves with the Slide and Title 
Masters. 
The Slide Master is the master for everything but title slides, and the Title Master 
is for only title slides. 
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Manipulating a built-in template  
 
Using your exercise 4 slides, click on the View menu and select Master --> Slide 
Master.  
 

 
 
You should see "Click here to edit" this that and the other thing.  
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Let's make an initial change and see what happens. Click and hold on the 
colored blocks on the left hand side and drag it all the way to the right hand side 
of the slide. 
Now switch back to Slide View to see what happened. The colored blocks should 
now be on the right hand side on all of your slides except the first. Why didn't this 
change affect the first slide? Because the first slide is a title slide and is  
controlled by the Title Master. Go back to the Slide Master and make some more 
changes to fonts and the position of objects. Got the hang of it? 
 

Making your own Slide Master  
  
You can make your own slide master if your start with a blank presentation. You 
would open the Slide Master View just like we just did and use the same tools 
that we used when we worked on making custom slides. 
 

The Title Master vs. the Slide Master  
 
This distinction between the Title Master & the Slide Master exists so that title 
slides can be controlled by their own master. The idea is that your presentation 
may be broken into a number of parts and that you might want each part to begin 
with a "title slide" that looks different from the rest of the slides in your 
presentation. When you create a new slide "Title Slide" is the first AutoLayout 
and selecting it will create a new title slide. None of the other Autolayouts create 
title slides. Note that you can use as few or as many title slides as you want in 
your presentation - you don't have to use them at all if you don't want to. When 
you make a new slide you decide whether you want it to be a title slide or not by 
virtue of the Autolayout you select. Now that we know that title slides are different 
from other slides it is clear what the Slide Master and Title Master do. The Slide 
Master is the master for everything but title slides, and the Title Master is for only 
title slides. Let's go to the hands-on exercises and try it out. 
The Title Master works exactly the same way as the Slide Master but it affects 
only title slides. Go ahead and make some changes and perhaps even insert a 
few new title slides into the presentation. 
Note: If you create your own masters from a blank presentation, the computer 
doesn't give you an option to make a separate Title Master. The Slide Master will 
be used for all slides. 
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Let's Practice! Exercise #5  
 
Let's practice what we have done so far by trying the following things: 
 

1. Open a new presentation.  
2. Make a Slide Master that looks like this:  
3. Go back to Slide View & add a few new slides to your presentation to see 

if your Masters are working. 
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Design Tips  
 
 Try to keep your slides as simple as possible so that your audience can 
concentrate on your message, not your fabulous PowerPoint skills. This includes: 
 

• Limit the number of colors you use. You should try to keep colors to about 
5. 

• Limit the number of graphics you use.  
• Use the Slide Masters. They help keep your presentation consistent.  
• Keep your Slide Masters simple.  
• Try to stick with light or white backgrounds with black or dark text.  If you 

are going to be using overheads, DO NOT use dark backgrounds.  You 
can start a fire. 

• Avoid busy backgrounds. They make it hard for your viewer to read the 
text.  

• Limit your use of animation & sound.  
• Try to limit the number of points on a page (remember, Power Point just 

gives the outline & key facts about your presentation, NOT every single 
detail.)  

• Try to keep the amount of information on each slide consistent. Research 
suggests that 5 to 9 points per slide is ideal.  

• Keep your format consistent-- give all your slides a common look.  
• When presenting via computer or the World Wide Web, it is best to use a 

San Serif font, such as Ariel. 
 


